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Software Server License Agreement
This AccuSoft software product ("Product") is a proprietary and copyrighted Product of 
Schellenbach & Associates, Inc. dba AccuSoft Enterprises ("ASE"). It is licensed (not sold) to you, 
and you may use this Product only on the terms of this license fromASE, even though you may 
have obtained the Product from a dealer or other source.

License
ASE grants you a non-exclusive license only to:

1. install and use the Internet Edition Designer on up to three (3) computers you own or use.
2. install and use the Internet Edition Client on any computers which your Company owns or 

uses. You may make copies of the Internet Edition Client as necessary to use the Product 
with other computers owned or used by your Company.

3. post AccuTerm Session files (.ats, .atss, .atsn) you create using the Product on a single 
Internet or intranet server or web site (the licensed server). Any and all AccuTerm Session 
files must be posted to the same licensed server or web site. If you change servers, you must 
remove all AccuTerm Session files from the old server. A separate license is required for 
each server or web site that AccuTerm Session files are posted to.

4. make one copy of the Product for archival or backup purposes in support of your use of the 
Product.

5. transfer the Product and this license to another party if the other party agrees to accept the 
terms and conditions of this Agreement. If you transfer the Product, you must at the same 
time either transfer or destroy all copies, including any portions of the product merged into 
other programs or stored on computer memory devices such as hard disks. IF YOU 
TRANSFER POSSESSION OF ANY COPY OR MERGED PORTION OF THE PRODUCT 
TO ANOTHER PARTY WITHOUT TRANSFERRING THE PRODUCT ITSELF AS 
PROVIDED HERE, YOUR LICENSE IS AUTOMATICALLY TERMINATED.

Except as otherwise provided in this agreement, you have no right under this license to rent, lease, 
transfer, or distribute the Product. You may use the Product in object code form only.

Title
Title and copyright to the Product, including theProduct media and documentation, remain with 
ASE. You are not the owner of this Product, but you have the right to use it in accordance with this 
license. You are not licensed to copy, reproduce or make data transmissions, in whole or in part, of 
the Product, except as is permitted in this license. You agree not to modify, reverse engineer, 
translate, disassemble or decompile the Product, in whole or in part.

License Term
The license is effective upon opening of the Product package or use of the Product and shall 
continue until terminated. You may terminate it at any time by destroying the Product together with 
all copies and the Product Documentation. THIS LICENSE WILL TERMINATE AUTOMATICALLY 
IF YOU FAIL TO COMPLY WITH ANY TERM OR CONDITION OF THIS LICENSE. Upon 
termination you agree to destroy the Product, the Product Documentation and all copies, purge the 
Product from all computers and memory devices such as hard disks, and eliminate the Product 
from any merged programs.

Limited Warranty
ASE warrants that for a period of six (6) months from date of purchase the Product will perform 
according to the specifications set forth in the associated Product Documentation and the diskette 
(or other medium) on which the Product is located will be free from defectsin materials and 
workmanship under normal use.

YOU ASSUME THE RESPONSIBILITY FOR THE SELECTION OF THE PRODUCT TO ACHIEVE 
YOUR INTENDED RESULTS, AND FOR THE INSTALLATION, USE AND RESULTS OBTAINED 
FROM THE PRODUCT. ASE does not warrant that the functions contained in the Product will meet 
your requirements or that the operations of the Product will be uninterrupted or error free, or will 
function properly in every hardware environment. This warranty gives you specific legal rights and 
you may also have otherrights which vary from state to state.



EXCEPT AS EXPRESSED HEREIN, THE LICENSED PROGRAM IS PROVIDED TO YOU "AS 
IS". ASE DISCLAIMS TO THE FULLEST EXTENT PERMITTED BY LAW ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, 
WHICH SHALL IN NO EVENT EXCEED ONE YEAR. Some states do not allow the exclusion of 
implied warranties so the above exclusion may not apply to you.

No person is authorized to modify the warranties contained in this license or make any different 
warranty for the Product.

Limitations of Remedies
ASE's entire liability and your exclusive remedy shall be limited to:

1. the replacement of any Product, including its diskette or other medium, that does not meet the 
standards of the limited warranty above. To use this warranty, you must return, at your 
expense, the Product and all copies along with a copy of your purchase invoice and a brief 
description of the defect to AccuSoft Enterprises, Customer Service Dept., 8041 Foothill 
Blvd., Sunland, CA 91040. Upon verification of the defect, ASE will send to you, at ASE's 
expense, a replacement Product. 

2. if ASE is unable to deliver a replacement which is free of defects, ASE will refund your 
purchase price.

IN NO EVENT WILL ASE BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST 
PROFITS, LOST SAVINGS, LOST DATA OR OTHER INCIDENTAL OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PRODUCT EVEN IF ASE 
OR ANY OF ITS DEALERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, 
OR FOR ANY CLAIM BY ANY OTHER PARTY. ASE'S MAXIMUM LIABILITY SHALL IN NO 
EVENT EXCEED THE PURCHASE PRICE YOU PAID FOR THE PRODUCT. Some states do not 
allow the limitation or exclusion of liability for incidental orconsequential damages so the above 
limitation or exclusion may not apply to you.

Customer Registration
ASE may from time to time revise and update its Product or provide useful customer information. 
You may wish to know about Product improvements and theavailability of upgrades. To obtain this 
useful service, you must fill out and return the enclosed customer registration card. ASE urges you 
to do so immediately.

General
You may not sublicense, assign or transfer this license or the Product to any otherperson or entity 
except as expressly allowed in this license. Any attempt to sublicense, assign or transfer is void.

This Agreement will be governed by laws of the State of California, exclusive of its choice of law 
provisions.

You further agree that this is the complete and exclusive statement of the agreement between us 
which supersedes any proposal or prior agreement, oral or written, and any other communications 
between us relating to the subject matter of this agreement.

If any provision of this agreement shall be held to be invalid, illegal or unenforceable, the remaining 
provisions shall not be affected.

If you have any questions concerning this license, you should contact AccuSoft Enterprises,  
Customer Service Dept., 8041 Foothill Blvd., Sunland, CA 91040, USA.
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INTRODUCTION

Welcome to AccuTerm 2K2 Internet Edition – the fastest way to deploy
legacy applications on the Web!

Features of AccuTerm 2K2 Internet Edition

Users can access legacy applications using Internet Explorer. The 
terminal emulator automatically downloads and installs and runs inside an 
Internet Explorer window.

No need to learn another application. The user only needs to know how to 
use Internet Explorer to navigate to your web site.

No charge for client license. You can allow an unlimited number of users 
to access your site with no per-client charges.

Telnet and Secure Shell connections for greatest flexibility and security. 
Both SSH1 and SSH2 are supported, with password or public key 
authentication.

Accurate emulations. When you use AccuTerm everything will work just 
like the terminal being emulated.  No strange problems with word 
processors or spreadsheets.  No messed up screens.  No hassles.

Visual Styles and full color mapping lets you choose any foreground and 
background color combination for any terminal visual attribute, and attach a 
border effect to the attribute.  Application of Visual Styles can give 
character-based applications an instant face-lift!

AccuTerm GUI compatible. Applications created using AccuTerm GUI 
can be deployed using AccuTerm Internet Edition.

Enhanced scroll back window saves up to 10,000 lines for instant recall.
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File transfer capabilities using industry standard protocols like Xmodem, 
Ymodem, Zmodem, and Kermit. MultiValue file transfer utilities import and 
export MultiValue data in a variety of formats.

Scripting language allows administrators to write scripts and macros using 
Visual Basic for Applications.

Extended screen support of up to 240 columns by 240 rows.

Automatic font scaling so that you can always see the full screen.  This is a 
great feature that once you get used to it, you'll never want to go without.
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Hardware and Software Requirements

Memory: 128MB

Processor: Pentium3-500 or better

Windows: 95, 98, ME, NT 4.0, 2000, XP, 2003, Vista

Internet Explorer: 3.02 or above (6.0 or above recommended)
NOTE: Netscape, Firefox & Opera browsers are not
supported.

Host Connection: permanent TCP/IP connection with public IP address 
for Internet access

User Connection: any TCP/IP connection to the Internet
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GETTING STARTED

This manual assumes that you have a working knowledge of the Windows 
environment, Internet, Internet Explorer and your host application’s terminal 
requirements.

Installation

To install AccuTerm 2K2 Internet Edition, insert the AccuTerm 2K2 
Internet Edition program CD and follow the prompts. 

1) Start the setup program:

Insert the CD. If the installation program does not 
automatically start, then from the Start menu, select Run. Enter 
“D:\Autorun.exe” and click OK.  Be sure to change the drive 
letter to the letter for your CD drive.

2) The AccuTerm 2K2 Installer will display the installation 
selection menu. Click the Install AccuTerm 2K2 Internet 
Edition Designer button. The installation wizard will guide 
through the installation process. You will be prompted to enter 
your authorization key, enter registration information, etc. You 
move forward through the installation process by clicking the 
Next button. You can click the Back button to move back, or 
the Cancel button to cancel the installation.

3) Enter your Authorization Key, found on the back of the CD 
sleeve, and click Continue.

4) Read the Software Server License Agreement and indicate 
your acceptance by clicking OK.

5) The AccuTerm Registration dialog box will be displayed. 
Please fill in the registered company and server names, then 
click the Next button.
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6) Select the directory where you want the AccuTerm program 
files to be installed, then click the Next button. Click the 
Browse button to change directories. If you already have 
AccuTerm 2K2 (or any version of AccuTerm) installed on your 
computer, be sure to install AccuTerm 2K2 Internet Edition 
into the same directory!

7) Select the “home” directory, where you want to store the 
session files you create using the program. By default, 
AccuTerm Internet Edition stores the session files in the “My 
Documents\AccuTerm Internet Sessions” folder.

8) You can choose if you want files which are replaced during 
installation to be saved in a backup directory. If you select this 
option, when you click the Next button, you can select the 
directory where replaced files are saved to.

9) Select a “Start Menu” folder for the AccuTerm 2K2 Internet 
Designer shortcut, then click the Next button. You can also 
place a shortcut to AccuTerm 2K2 Internet Designer on your 
desktop.

10) To begin installing files, click the Next button. The installation 
progress will be displayed. When the installation is complete, 
you can view the release notes by checking the “View release 
notes” box, and clicking Finish. If you do not want to view the 
release notes at this time, simply clear the “View release 
notes” box and click Finish.

During installation, you may get a message indicating that the OLE system 
files are in use.  If this occurs, please shut down all other applications, then 
click the OK button to restart Windows. After Windows restarts, re-start the 
installation procedure.
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Overview of AccuTerm 2K2 Internet Edition

AccuTerm 2K2 Internet Edition is designed to let users access legacy host 
applications over the Internet by clicking on a hyperlink on a web page. The 
AccuTerm components are automatically downloaded and installed on the
user’s computer by Internet Explorer. The terminal emulation settings are 
downloaded from the web server, and a Telnet or Secure Shell connection to 
the host computer is established inside the Internet Explorer browser 
window. You do not need to modify your application, and the user does not 
need to install any new programs to access your terminal-based application.

AccuTerm 2K2 Internet Edition consists of two components: the Connection 
Designer, which is used by the administrator to create and modify 
AccuTerm Internet Session Connection (.atss and .atsn) files, and the 
AccuTerm 2K2 Internet Client, which is invoked by Internet Explorer to 
display the terminal session within the browser window.

This manual describes how to create or modify AccuTerm 2K2 Internet 
Sessions using the Connection Designer, how to deploy the session
connection files and associated html code in a web page, and the terminal 
emulation features supported by the AccuTerm 2K2 Internet Client.
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Quick Start

To get started quickly, make sure the minimum requirements for deploying 
AccuTerm 2K2 Internet Edition are met:

1) The host you want to connect to is connected to the Internet (or 
intranet if creating a local connection).

2) You have access to a web server somewhere on the Internet 
where you can install the AccuTerm connection files.

3) The PC you are installing the AccuTerm 2K2 Internet Designer 
program onto has Internet Explorer 4.0 or higher.

4) If you are using Secure Shell to connect to the host, make sure 
the PC has 128 bit encryption installed. To check the encryption 
strength, open Internet Explorer, select About from the Help menu 
and check the cipher strength displayed in the about box.

Create a new connection
Start the AccuTerm 2K2 Internet Edition Connection Designer from the 
Start menu. Click the button or select New from the File menu. 
Choose safe or unsafe connection. Enter a file name to save your new 
connection under. Click OK. Note: a safe connection does not imply a 
secure connection!

Configure the new connection
Click the button or select Settings from the Tools menu. Enter your 
connection settings just as you would for a normal AccuTerm terminal 
session.

Customize your connection script
Click the button or select Edit Script from the Tools menu if you 
want to customize the Connect or Disconnect script.
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Test your connection
Click the button, or select Connect from the Tools menu. See how 
your new connection works, including the Connect script. When you are 

finished, click the button (or Disconnect from the Tools menu) and 
see if the connection terminates correctly. If you encounter any problems, 
adjust your settings or script until it works correctly.

Save the connection file and HTML link file
Click the button or select Save from the File menu. Check the 
appropriate HTML option (usually you will want to save the Internet HTML 
file) and GUI option (only select if your host application requires AccuTerm 
GUI support; checking this option increases client download time). Click 
the Save button.

Deploy your connection
Upload your new session connection (.atss, .atsn) file and HTML link file to 
your web server. Modify an existing web page to link to the new HTML link 
file. Open the HTML link file with Notepad (or other text editor) and copy 
the sample link and paste into your web page to create the hyperlink.

Try it!
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CONNECTION DESIGNER

The Connection Designer is used by the administrator to create and maintain 
AccuTerm Internet Session Connection files (.atss and .atsn files). The 
session connection file contains all information required to make a
connection to the host, including host name (or IP address), connect and 
disconnect scripts, terminal type, screen size, function keys, colors, etc.The 
default file extension for safe connections is “.atss”. Unsafe connections use 
“.atsn”. The older “.ats” file extension is obsolete and should not be used.

To start the Connection Designer, simply select 
from the Start menu. The 

AccuTerm 2K2 Internet Edition Connection Designer main window will 
be displayed:

The designer window is divided into two panes: the left pane contains a set 
of buttons for creating new sessions, opening existing sessions, etc. The 
right pane contains a preview of the terminal session as it would be 
displayed in the browser.
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Creating and Modifying AccuTerm Internet 
Connections

Creating a new connection
To create a new session, select New from the File menu or click the 
button. When creating a new connection, you must select the session file 
name before the session file can be created. Use “.atss” for the file extension
if you are creating a safe connection. Use “.atsn” if you are creating an 
unsafe connection. If you use another extension, the Connection Designer 
may not recognize the file, and the user may be required to confirm a “file 
download” to establish the connection. After creating a new session file, the 
preview pane will display a preview of the terminal session.

Safety Level
When you create a new connection, you must also select the “safety” level 
for the connection you are creating. The safety level is used by the browser 
to warn the user if potentially unsafe content is about to be accessed, or to 
block access to potentially unsafe content. You can choose to create a safe
or unsafe connection.

When you choose to create a safe connection, AccuTerm’s functionality is 
restricted to protect the user’s computer from any actions which might alter 
any files or settings. A safe connection cannot perform file transfers, data 
capture, execute DOS/Windows command, or execute any script statement 
which could alter the user’s computer.

The following VBA statements and functions are not supported in “safe” 
connections:

Open Print Close
Put Declare Shell
Kill CreateObject GetObject
ChDir ChDrive FileCopy
MkDir Name RmDir
SetAttr Write DDEInitiate
DeleteSetting SaveSetting App…
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When you choose to create an unsafe connection, all of AccuTerm’s 
features are available, but the browser will refuse to open the session file if 
the browser’s security level for the web site or zone is high. The user will be 
prompted to allow a potentially unsafe ActiveX control to run. If you deploy 
an unsafe connection, it is recommended that the site be added to the user’s 
Trusted zone, and the “Initialize and script ActiveX controls not marked as 
safe” security setting be set to “Prompt”.

To change the browser’s security level, select Internet Options from the 
browser's Tools menu, then click the Security tab. You can also adjust the 
security level by double-clicking on the Internet icon in Control Panel.

The following security settings are required for safe connections:

Download signed ActiveX controls: Enable or Prompt
Run ActiveX controls and plug-ins: Enable or Prompt
Script ActiveX controls marked safe for scripting: Enable or Prompt
File Download: Enable
Active scripting: Enable or Prompt

The following security settings are required for unsafe connections:

Enable Protected Mode: unchecked (Windows Vista)
Download signed ActiveX controls: Enable or Prompt
Initialize and script ActiveX controls not marked as safe: Prompt
Run ActiveX controls and plug-ins: Enable or Prompt
Script ActiveX controls marked safe for scripting: Enable or Prompt
File Download: Enable
Active scripting: Enable or Prompt

When running Internet Explorer 7 under Windows Vista, a new “Protected 
Mode” is typically used for all sites not in the Trusted zone. An unsafe
connection cannot be run properly in Protected Mode. If a user attempts to 
open an unsafe connection in Protected Mode, they will be asked whether to 
allow the connection to open with reduced functionality, or cancel the 
connection. If they continue, the connection will be open with the same 
restrictions as a safe connection (see above).

Modifying an existing connection
To modify an existing session file, select Open from the File menu or click 

the button.  After opening a session file, the preview pane will 
display a preview of the terminal session.
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Upgrading from AccuTerm 2000 or AccuTerm 97 Internet Edition
The AccuTerm 2K2 Internet Connection Designer is capable of upgrading 
your existing session files which were created with theAccuTerm 2000 or 
AccuTerm 97 Internet Connection Designer. When you open a file created 
with an older version, you will be given the option to convert the file to the 
2K2 version. Choose a new file name for the AccuTerm 2K2 version of the 
connection file.

The conversion process preserves all settings and scripts. However, due to 
changes made in the newer versions, the “reconnect” message that is 
normally displayed when the connection is dropped requires a new 
Disconnected script function. This new function will be automatically 
added to your script.

Closing a session file
If you wish to close the session file you currently have open, select Close 

from the File menu or click the button.  If you have made changes to 
the settings or script for the session, you will be warned before the file is 
closed so you can cancel your action and save the changes.
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Saving a session file
If you wish to save the current session file, select Save from the File menu 

or click the button.  The process of saving also closes the file. If you 
have made changes to the settings or script for the session, you will be 
warned before the file is closed so you can cancel your action and save the 
changes.

When you save the session file, you can also create an HTML link file 
which you can use as a hyperlink target in your current web page. The 
HTML link file can be either an “Internet” or an “intranet” version.

If you choose “Internet” HTML, the generated link file will cause Internet 
Explorer to install the AccuTerm 2K2 Internet Client programs on the user’s 
machine from AccuSoft’s web site.

If you choose “intranet” HTML, the generated link file will cause Internet 
Explorer to install the AccuTerm 2K2 Internet Client programs from the 
atiecli5.cab file located on the web server where the .atss or .atsn session
connection file is located.

You can also choose to include special code in the HTML link file which 
will cause Internet Explorer to install the AccuTerm GUI support code. To 
reduce download time, select this option only if your host application uses 
AccuTerm GUI. If you are deploying AccuTerm 2K2 Internet Edition on an 
intranet, and are using AccuTerm GUI, you must also place a copy of 
atguisvr_install.cab on your web server.



16 Connection Designer

AccuTerm Internet Connection Settings

Once a session file has been created or opened, use the Settings dialog to 
configure the session. To open the Settings dialog, select Settings from the 

Tools menu or click the button.

The Settings dialog is organized into ten index tabs. Click on one of the 
index tabs to display the settings for that category. You can also press the 
number of the tab while holding the ALT key.

When you have completed your changes, simply press ENTER (or click the 
OK or Apply button) to save changes, or press ESC (or click the Cancel
button) to discard changes and close the Settings dialog box.
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Connection Settings

Connection Method
The Connection Method is used to select what type of connection or 
communications device you use between your computer and the host 
system. Since AccuTerm 2K2 Internet Edition is designed to enable 
connections over the Internet (or intranet), you will normally select Telnet,
or Secure Shell for the connection type. Only settings for Telnet and Secure 
Shell are described in this document; refer to the standard AccuTerm 
product documentation for information pertaining to other connection types.

After selecting or changing the connection type, settings relating to the 
selected connection type are enabled. For example, if Telnet is selected, 
various options for a telnet connection, such as the host name, port and 
timeout will be displayed. The settings for each connection type will be 
described later in this section.

Duplex
There are three duplex options: Full, Half and Local. In Full duplex, all 
characters typed on your keyboard are sent to the host computer. They are 
not printed on the screen. The host usually sends (echoes) the same 
character back; this is what is displayed on the screen. This is by far the 
most common configuration. In Half duplex, the characters you type are 
sent to the host machine and displayed on the screen. If the host system is 
configured for Full duplex and you select Half duplex on your computer,
you will see each character that you type two times! In Local mode, 
characters you type are displayed directly on the screen and are not sent to 
the host computer.

Strip Eighth Bit
Most connection types use eight bits to represent each character. When 
using eight bits, the computer can send up to 256 different character codes. 
Some terminal types have no way of handling characters above 127 (hex 
7F). In this case, you can check this box and the eighthbit of each byte will 
be automatically stripped from all received characters. If you need to use 
any international characters or special symbols from the PC character set, 
you will need to clear this box to access them (the Wyse 60 and VTxxx 
emulations have commands to access these characters when using only 7 
bits).
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Connection Settings - Telnet

AccuTerm supports Telnet connections to host systems over a TCP/IP 
network.  Any Telnet server (host) on the network, including hostson the 
Internet, can be accessed.

Host Name
A valid Telnet host name or IP address must be entered in this field. If a 
HOSTS file is available, you can click on the down-arrow to display a list of 
available hosts.

Host Type
If your type of host you are connecting to is listed in the Host Type list, 
please select it, otherwise just use the default host type. By selecting a host 
type from this list, certain advanced options are set up to be compatible with 
the specified host type. To see the advanced options, click on the Advanced 
button.
Port
If the Port field is left blank, or set to “default”, AccuTerm will use TCP 
port 23 (the default for Telnet).  If a different port is used for Telnet onyour 
desired host machine, enter that port number in this field.

Certain host systems, such as Raining Data D3, allow a host process number 
(PIB) to be mapped to a specific TCP port number. You can use the Port 
setting to specify the port number mapped to your process number. Consult 
with your system administrator for this setting.

Connect Timeout
When establishing a connection to a host computer, AccuTerm will wait for 
a specified time for a response from the selected host system. You can 
specify the number of seconds AccuTerm should wait.  If this field is left 
blank, or zero, the default timeout is 15 seconds.

Note: this timeout only affects the time AccuTerm waits for a response from 
the host when opening a connection to the host.

Advanced Options
By clicking on the Advanced… button, you can modify various Telnet 
options. These options are generally set by selecting a Host Type, but may 
be modified if necessary.
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If you change any settings in the Advanced Telnet Options, the host type 
you have previously selected will be changed to “custom”.

Echo (advanced option)
Most systems require the host to “echo” characters it receives back to the 
client (terminal).  That is, when you press a key, a character is sent to the 
host, and the host sends that same character back to the terminal, at which 
time it is displayed on the screen.  If this behavior is desired, then select the 
echo option (default).  If the echo option is not selected, then the Duplex 
setting should be changed to “half” to enable local echo of typed characters.

Binary (advanced option)
Normally, Telnet operates in Text mode, with special rules for handling CR
and LF characters. When the Binary option is selected, Telnet sends CR and 
LF characters without any alteration. Some hosts do not function correctly in 
Binary mode.

Use alternate break signal (advanced option)
Normally, Telnet sends the Interrupt Process command when you press 
CTRL+BREAK. Key.  When this option is selected, Telnet sends the Telnet 
Break command instead.

Bypass option negotiation (advanced option)
When this option is selected, Telnet option negotiation, which normally 
occurs when establishing a connection, is skipped. Certain Telnet servers, 
like Raining Data D3, do not support Telnet option negotiation, and require 
this option.

Send keepalives (advanced option)
When this option is selected, AccuTerm will send a dummy “keepalive” 
message to the host periodically (about every 2 minutes). This dummy 
message is discarded by the host and is transparent to the terminal session. 
This feature may be useful when the host system (or network equipment 
such as a router) disconnects an idle connection.

Note: certain Telent servers, like Raining Data D3 running on NT or 2000, 
are not compatible with this option.

Disable outbound coalescing (advanced option)
Use this option to improve terminal response over the network, at the 
expense of increased network traffic.
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Use U2 device licensing (advanced option)
By selecting this option, multiple connections (sessions) to Enterprise 
versions of UniData and UniVerse consume only a single user license. 
When the Suppress LF option is checked, the response sent to the host by 
AccuTerm is not terminated by an LF (line feed) character. Contact your 
IBM U2 dealer for information regarding device licensing.

Terminal Type (advanced option)
Many Telnet servers allow the client (terminal) to specify a terminal type 
when a connection is established.  AccuTerm uses the default terminal types 
of tty, viewpoint, viewpoint60, wyse50, wyse60, vt100, vt220, vt320, vt420, 
vt52, ansi, linux and pickmon, depending upon the selected terminal 
emulation.  If a different terminal type is required, you can enter it in this 
field.



Connection Designer 21

Connection Settings – Secure Shell (ssh) 

AccuTerm supports secure connections to host systems over a TCP/IP 
network using Secure Shell (ssh).  Any ssh server on the network, including 
hosts on the Internet, can be accessed. AccuTerm implements both version 1 
and version 2 of the Secure Shell protocol. Protocol selection is usually 
automatic and uses version 2 if it is supported by the host. Otherwise, it 
automatically falls back to version 1.

Secure Shell employs public key encryption technology to ensure that your 
connection to the host is secure, even over the Internet. When you set up a 
Secure Shell connection, all information, including your user ID, password 
and session data is encrypted before transmission over the network.

AccuTerm Secure Shell requires Windows 128 bit encryption. To verify that 
you have the 128 bit encryption installed, open Internet Explorer, and select 
About Internet Explorer from the Help menu. If Cipher Strength is 128-
bit, then you should be able to create a Secure Shell connection. If it is not, 
you may need to upgrade you version of Internet Explorer to version 6 or 
higher, or install the High Encryption Pack (search for “High Encryption” at 
www.microsoft.com).

Host Name
A valid SSH host name or IP address must be entered in this field.  If a 
HOSTS file is available, you can click on the down-arrow to display a list of 
available hosts.

Port
If the Port field is left blank, or set to “default”, AccuTerm will use TCP 
port 22 (the default for ssh).  If a different port is used for ssh on your 
desired host machine, enter that port number in this field.
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Connect Timeout
When establishing a connection to a host computer, AccuTerm will wait for 
a specified time for a response from the selected host system. You can 
specify the number of seconds AccuTerm should wait.  If this field is left 
blank, or zero, the default timeout is 15 seconds.

Note: this timeout only affects the time AccuTerm waits for a response from 
the host when opening a connection to the host.

SSH Version
Select the version of the SSH protocol that will be used by the connection. 
When you select “auto”, AccuTerm will automatically select the highest 
version supported by the host. If you select SSH1 or SSH2, AccuTerm will 
only connect using the selected protocol. If the host does not support the 
selected protocol, the connection will fail and an error message will be 
displayed.

Authentication
Select the authentication method which will be use to validate the user with 
the host.  AccuTerm supports both password and public key authentication.

Key
If public key authentication has been selected, click the Select… button to 
open the Key Management dialog. Use the Key Management dialog to 
create new keys, load existing keys and import keys created on another 
system.

Advanced Options
By clicking on the Advanced… button, you can modify various Secure 
Shell options.

Break character (advanced option)
Specify the character used to indicate a Break in this field. The default is 3 
(CTRL + C) but you can enter any ASCII code in this field if your host 
requires a different break character.

Terminal Type (advanced option)
Many hosts allow the client (terminal) to specify a terminal type when a 
connection is established.  AccuTerm uses the default terminal types of tty, 
viewpoint, viewpoint60, wyse50, wyse60, vt100, vt220,vt320, vt420, vt52, 
ansi, linux and pickmon, depending upon the selected terminal emulation.  
If a different terminal type is required, you can enter it in this field.
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Preferred Cipher (advanced option)
If you wish to select the cipher used to encrypt the SSH session, you can 
select it from this list. If “auto” is selected, the default cipher (triple DES) is 
used. Otherwise, you can choose triple DES, Blowfish, 128 bit AES or 256 
bit AES. Note: the AES cipher is only available when using the SSH2 
protocol, and requires Windows XP.

Must Use Preferred Cipher (advanced option)
When this option is set, the cipher selected above must be supported by the 
host. If the selected preferred cipher is not supported by the host, the 
connection will be terminated and an error message displayed. When this 
option is not set, if the preferred cipher is not supported by the host, a 
different, mutually supported, cipher (normally, triple DES) will be used.

Send keepalives (advanced option)
When this option is selected, AccuTerm will send a dummy “keepalive” 
message to the host periodically (about every 2 minutes). This dummy 
message is usually discarded by the host and is transparent to the terminal 
session. This feature may be useful when the host system (or network 
equipment such as routers) disconnects an idle connection.

Disable outbound coalescing (advanced option)
Use this option to improve terminal response over the network, at the 
expense of increased network traffic.

U2 device licensing (advanced option)
By selecting this option, multiple connections (sessions) to Enterprise 
versions of UniData and UniVerse consume only a single user license. 
When the Suppress LF option is checked, the response sent to the host by 
AccuTerm is not terminated by an LF (line feed) character. Contact your 
IBM U2 dealer for information regarding device licensing. Note: at this 
time, AccuTerm does not support U2 device licensing for Windows versions 
of U2.
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Connection Settings – SSH Key Management

When configuring a Secure Shell connection, AccuTerm supports both 
password and public key authentication. When public key authentication is 
selected, click the Select… button to open the Key Management dialog. 

Use the Key Management dialog to create public/private keys for SSH, or to 
load or import private keys. AccuTerm supports RSA public keys for both 
SSH 1 and 2, and DSA public keys for SSH 2. AccuTerm can import SSH 2 
private keys that were created by OpenSSH. The public key file format 
AccuTerm uses is also compatible with OpenSSH (www.openssh.org).

Creating a new key
Click the Create New Key button to create a new public/private key pair. 
After clicking the Create New Key button, select the key type (RSA or 
DSA), and key length. The default length of 1024 bits is recommended. 
Enter a descriptive comment describing the key being created, and enter a 
passphrase to protect your private key. Although the passphrase is optional, 
it is highly recommended since anyone that gains access to your private key 
file can impersonate your identity! Once the passphrase is confirmed, the 
icon to the right of the passphrase field changes from a red X to a green 
check-mark. 

Click the Generate New Key button to generate the new key pair. This 
process may take some time to complete. When key generation is finished, 
the “fingerprint” for the public key will be displayed.

Click the Save Key File button to save the newly created key file. By 
default, AccuTerm will save the key in its standard key folder. You can 
select a different location, such as a removable USB drive, if desired.

Once your key pair is created, you need to place the public key on the server 
which you want to connect to. You can save the puclic key to a file by 
clicking the Copy Public Key button with the to file option selected. Once 
saved, you could attach the key to an email message and send it to the 
server’s administrator (it is a public key, so security is not a major issue). 
You could also save the public key file to a removable drive or diskette and 
mail or take it to the server administrator.
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If the server uses OpenSSH (or compatible) files, and if you currently have 
access to the server via password authentication, you can set up public key 
authentication using the following steps:

1) Open an AccuTerm session and connect to the server. Log in using 
your password.

2) Open the AccuTerm Settings dialog to create your new key pair. 
Click the Connection tab. Change the setting for Authentication
from password to public key.

3) Click the Select… button to open the Key Management dialog.

4) Click the Create New Key button and follow the steps above for 
creating a new key.

5) Select the to clipboard option and click the Copy Public Key
button to copy the public key to the clipboard.

6) Click OK two times to dismiss the dialogs. Ignore the warning 
about changes not being effective.

7) From a Unix/Linux prompt, change to your ~/.ssh directory. Edit 
the authorized_keys2 file using your favorite text editor. Start a 
new line in the authorized_keys2 file.

8) From the AccuTerm Edit menu, choose Paste to paste the public 
key into the authorized_keys2 file.

9) Save the modified authorized_keys2 file.

10) Save the modified AccuTerm session file. Close AccuTerm. Open 
AccuTerm and choose the session file you just modified.

11) Enter your user ID.

12) If you entered a passphrase when you created your new key, you 
will prompted to enter the password. Enter the passphrase (case 
sensitive).

13) If the server accepts your key, you will be logged in.

Loading an existing key
If your private key was saved to a different folder or to a removable drive or 
diskette, you can click the Load Existing Key button to load that key. Enter 
the passphrase and click the Verify button to check the passphrase. If the 
passphrase is correct, the public key fingerprint will be displayed. Click OK
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to use this key (in its current location). Otherwise, you can save the key in a 
different location by clicking the Save Key File button.

Importing a key
Importing a key is exactly like loading an existing key, except for the file 
locations. AccuTerm can import private keys created using the OpenSSH 
file format.

Key fingerprint
When you create a new key, or load or import an existing key, AccuTerm 
displays the “fingerprint” of the public key. You canuse this fingerprint to 
ensure that your key is correct. Use a utility on the server to show the 
fingerprint of the public key and compare to the fingerprint shown in 
AccuTerm.



Connection Designer 27

SSH Key Location

After configuring a Secure Shell connection using public key authentication, 
the SSH Key Location dialog is displayed. Options in this dialog are used 
to specify how the private key is accessed on the client PC when opening the 
connection.

Remember that public key authentication requires two keys: a public key
stored on the host, and a private key accessible to the client PC.  AccuTerm 
Internet Edition provides three options for the client PC to access the 
private key.

Prompt user for key when connecting
Select this option if you want to prompt the user for the private key file 
location. The standard Windows File Open dialog will be displayed when 
the connection is opened. If you select this option, be sure to give the user a 
copy of the private key (in a secure manner)with instructions on where to 
load the key.

Embed this key in the session (.ats, .atss, .atsn) file
Select this option to embed the contents of the private key within the session 
connection (.ats, .atss or .atsn) file. If this option is selected, it is 
recommended that the session connection file be delivered from a secure 
site using https.

Read this key stored on client PC
Select this option to read the private key from a known location on the client 
PC. If a full path is not specified, the default AccuTerm key folder 
(C:\Documents and Settings\USERNAME\Local Settings\Application 
Data\Asent\Atwin2k\ssh\keys ) will be used. If you select this option, be 
sure to give the user a copy of the private key (in a secure manner) with 
instructions on where to load the key.
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Terminal Type Settings

AccuTerm emulates a variety of terminals.  In order to use AccuTerm with 
your host applications, you must select the correct terminal type for 
AccuTerm to emulate. The correct terminal type depends on the terminal 
type your host and/or application software requires. If you are unsure, you 
might type “TERM” at a MultiValue (D3, U2, jBase, etc.) command (TCL) 
prompt, or type “echo $TERM” at a Unix command prompt. The response 
may help you “guess” the correct type. If the application screens look 
correct, then you probably have the correct type; otherwise, try another 
terminal type.

Terminal Emulation

Wyse 50: emulates a Wyse 50 terminal with “Enhanced” enabled.
Wyse 50 emulation may also be used for Wyse 30, 99, 125 and 350 
terminals.

Wyse 60: emulates a Wyse 60 terminal with “Enhanced” enabled. 
Wyse 60 emulation is similar to Wyse 50 with non-embedded visual 
attributes (the visual attribute codes do not take a position on the 
screen). Wyse 60 emulation may also be used for Wyse 150, 160 and 
320 terminals.

ADDS Viewpoint A2: emulates an ADDS Viewpoint A2 terminal. 
This is the original A2 terminal, with no enhancements.

ADDS Viewpoint 60: emulates an ADDS Viewpoint 60 terminal. The 
Viewpoint 60 is similar to the A2, but uses embedded visual attributes 
(the visual attribute codes take a position on the screen).

Procomm VP60: emulates an ADDS Viewpoint 60 terminal, but with 
non-embedded visual attributes. This emulation is similar to the 
Viewpoint 60 emulation provided by Procomm.

Viewpoint A2 Enhanced: emulates a Wyse 50 terminal in ADDS 
Viewpoint mode with “Enhanced” enabled. This is basically a hybrid of 
Wyse 50 and ADDS Viewpoint A2. Viewpoint A2 Enhanced may also
be used for ADDS 2020 and 4000, and NCR 2900 terminals.
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MDIS P30 (Prism): emulates a McDonnell Douglas Prism P30 
terminal.

VT52: emulates the DEC VT52 terminal.

VT100: emulates the DEC VT100 terminal. VT100 is a 7-bit 
emulation, and can also be used for applications which require VT102 
terminals.

VT220: emulates the DEC VT220 terminal. The VT220 emulation 
provides a super-set of the VT100 commands, and includes support for 
a host-writable status line, protected characters, multiple character sets 
and multiple pages.

VT320: emulates the DEC VT320 terminal. The VT320 emulation 
provides a super-set of the VT220 commands, and includes support for 
reporting and restoring various terminal states.

VT420: emulates the DEC VT420 terminal. The VT420 emulation 
provides a super-set of the VT320 commands, and includes support for 
rectangle operations, left & right margins, and horizontal split screen.

ANSI BBS: emulates the old MS-DOS ANSI.SYS device driver. This 
emulation may be useful when connecting to older bulletin board 
systems.

Linux Console: emulates the Linux console, including function keys 
and colors.

SCO Console: emulates the SCO Unix console.

Pick PC Monitor: emulates the original Pick PC Monitor (“mm-mon” 
or “I” terminal type), including color and function keys.

Tektronix 4014: emulates the Tektronix 4010/4014 terminals. Color 
enhancements as implemented in the CIT467 terminal (from CIE 
Electronics) are included. 

Tektronix 4100: partially emulates the Tektronix 41xx terminals. 

TTY Emulation: emulates basic TTY functions.

Status Lines
Some of the terminals that AccuTerm can emulate display status, function 
key labels or host messages on the top or bottom lines of the screen. If you 
select a terminal emulation that supports status lines, the supported status 
line options will be enabled for you to select.
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For Wyse and ADDS emulations, up to 3 status lines are available: a host 
message line at the top of the screen, and a “shifted” label line and 
“unshifted” label line at the bottom of the screen. For VT emulations, only a 
single status line is available for displaying a message from the host at the 
bottom of the screen. For the console emulations, the status line is not 
supported.

No message or status line
Select No message or status line if you do not want any status or 
message lines.

Shared message & status line
Select this option to use a single, shared line at the bottom of the 
screen. If the native terminal supports more than one line (Wyse 
and ADDS Viewpoint), the bottom row of the screen displays the 
most recently used line. The line is shared between label line, 
shifted label line and host message line.

Split message & status lines
Select this option if you want two separate status lines. The host 
message line is the top row of the screen display, and the label line 
is displayed on the bottom row. If the shifted label line is 
programmed, pressing the SHIFT key displays the shifted label line. 
Releasing the SHIFT key displays the unshifted label line.

Answerback
The contents of the Answerback field are sent to the host when AccuTerm 
receives a request to transmit the answerback string under Wyse and VT 
emulations.  When the answerback message is sent to the host under Wyse 
emulation, an ACK control character follows the message.  Under VT 
emulation, no terminator is sent.

Control characters may be entered into the answerback field by prefixing the 
character with a caret (̂ ).

ANSI Options
When any of the ANSI emulations (VTxxx, Linux Console or SCO 
Console) is selected, several additional options may also be selected.



Connection Designer 31

Send 8 bit controls
When this option is selected, AccuTerm will send control 
characters from the C0 and C1 sets. If the option is not set, C1 
controls are sent using an equivalent 7-bit escape sequence.

Allow application mode
When this option is selected (default), commands that switch the 
numeric keypad keys and cursor keys into “application mode” are 
recognized. When the option is not selected, those commands are 
ignored, preventing the terminal from switching to “application 
mode”. This option is useful when the host or application 
erroneously sends the command to enter application mode.

Keypad sends application codes
When this option is selected, the numeric keypad sends application 
codes (similar to function keys). When not selected, the numeric 
keypad sends numbers.

Cursor keys send application codes
When this option is selected, the cursor (arrow) keys send special 
application codes instead of cursor movement codes.

Backspace key sends DEL
When this option is selected, the BKSP key sends the DEL control 
code. When not selected, the BKSP key sends the BS control code.

Auto-print works just like VT terminal
When this option is selected, the “auto print” slave printer function 
works the same as a real VT terminal. That is, when AccuTerm is 
in “auto print” mode, the entire screen line that the cursor is on is 
printed when AccuTerm receives a CR, LF or FF control code. If 
this option is not checked, then text is printed as it is received from 
the host (similar to Wyse auto-print mode).
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Screen Settings

The Screen tab lets you set terminal screen options like the screen size, 
cursor type, and history rows.

Screen Sizes
There are two separate screen sizes that AccuTerm supports; normal and 
extended. These sizes are used to emulate the 80 and 132 column modes of 
the Wyse and VT terminals. AccuTerm has taken the extended and normal 
modes one step further. With AccuTerm you can define both the normal and 
extended modes to be any number of columns or rows up to a maximum of 
240 columns by 240 rows.

You will probably leave these settings at their default settings of 80 
characters by 24 rows for normal mode and 132 characters by 24 rows in 
extended mode. If you have software that supports other screen sizes, you 
can experiment with these settings until you find a size that you like.

The number of rows may change if you change terminal emulations. The 
console terminal emulations use 25 rows with no status line; others use 24 
rows with one or more status lines.

When AccuTerm switches between the normal and extended modes, one of 
two things will happen: either the characters will change size to fit the 
visible screen, or scroll bars will be displayed if the full screen will not fit 
within the current window at the selected character size. For more 
information on scaleable fonts, see the section on Fonts.

Video Pages
Many of the terminals AccuTerm emulates support multiple addressable 
pages. With AccuTerm, you can have up to 25 pages. Each page requires 
memory, so if you don't use them, it is better to leave this number set to the 
default value of 1.

History Rows
AccuTerm supports a “history buffer”, which saves lines that have scrolled 
off of the terminal screen.  To use this feature, specify how many rows (up 
to 10,000) are to be saved.  When the history buffer has been enabled (by 
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setting the number of rows), use the vertical scroll bar, mouse wheel, or 
keyboard commands to scan history.

You can use CTRL + SHIFT + PGUP, CTRL + SHIFT + PGDN, CTRL + SHIFT

+ UP, CTRL + SHIFT + DOWN, CTRL + SHIFT + HOME, and CTRL + SHIFT + 
END to scan the history buffer.

History Scroll Bar
When a history buffer has been enabled, the vertical scroll bar may used to 
scan through the history. AccuTerm supports three scroll-bar settings.

Auto: when “Auto” (the default mode) is selected, placing the mouse 
near the right edge of the screen will cause the scroll bar to “slide” into 
place. Moving the mouse away from this area causes the scroll bar to 
disappear.

On: when “On” is selected, the scroll bar will always be present.

Off: when “Off” is selected the scroll bar will only be present if the 
window height is not large enough to display the current screen height.

Note: when Auto or Off are selected, using the keyboard commands or 
mouse wheel to scan history causes the scroll bar to be displayed briefly. 
This is so that you can see the position of the scroll button after scrolling 
the window.

Enable Tektronix Graphics
Checking this box enables the Tektronix 4010/4014/41xx graphic terminal 
emulation. If the graphics mode is enabled, AccuTerm will automatically 
switch to the Tektronix graphic emulation when it receives the appropriate 
command from the host computer. AccuTerm will return to the previous 
emulation mode when graphics mode is terminated.

There may be times when you want to disable the graphic emulation. If you 
have a bad modem connection and are getting random garbage characters on 
the screen, AccuTerm may accidentally switch into graphics mode. 
Sometimes a software program may send the graphics mode control 
sequence at the wrong time. If this happens, disable the graphics mode until 
you need it.
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Enable Mouse
This option determines whether host mouse support is enabled. Under 
normal operation, if you click on the terminal screen with the mouse, 
nothing happens. If a “mouse on” command is received from the host while 
this option is checked, AccuTerm sends a special code informing the host of 
the mouse location when the button was pressed, and which mouse button 
was pressed. The mouse cursor is also changed to a “pointing hand” to 
indicate that the mouse is active.

Block Cursor
Checking this option turns the cursor into a blinking block instead of an 
underline.

Extended Mode
Checking this option sets the screen to extended (132 column) mode. This 
can be used to manually switch between extended and normal (80 column) 
modes.

Disable Line Wrap
When this option is checked, automatic line-wrap is disabled. When the 
cursor reaches the end of a line, typing another character normally causes 
the cursor to move to the beginning of the next line. When this option is set, 
the cursor does not move.

Disable Blinking
Checking this option disables the “blinking” visual attribute.  Characters 
tagged with the blink attribute will not blink.

Disable Underling
Checking this option disables the “underline” visual attribute.  Characters 
tagged with the underline attribute will not be underlined.
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Font Settings

AccuTerm displays text received from the host computer using a fixed-pitch 
(all characters are the same size) font. Using a fixed-pitch font is necessary 
because applications written to display on real terminals expect each 
character to be the same width in order to align columns of data on the 
screen.

AccuTerm supplies a custom font which is selected by default. You are free 
to choose another fixed-pitch font if you desire, however, AccuTerm’s font 
has been designed to scale nicely to different screen sizes.

Font
The font list shows all of the available fixed-pitch fonts installed on your 
computer. The first font listed is the AccuTerm font. This font has been 
optimized to look good over a wide range of character sizes and screen 
resolutions. We recommend that you use this font, especially if you have a 
low resolution screen (640 x 480).

To choose a different font, simply click on the font you want.

Font Size
This box lists all font sizes available for the font selected in the Font list. 
The Font Size list is disabled if the Scale Font to Fit option is checked.

Scale Font to Fit
When this option is checked, AccuTerm automatically re-sizes the selected 
font so that the entire terminal screen is visible. This allows you to re-size 
the screen or change between normal and extended video mode without 
having to deal with scroll bars to see everything. However, if for some 
reason, you need lock the characters at a specific size, you can un-check this 
setting and then pick the size you want from the Font Size list.

Use Bold Font Style
If this option is checked, AccuTerm uses the Bold font style if it's available 
in the selected font.
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Keep Font Legible
If this option is checked, and the Scale Font to Fit option is checked, 
AccuTerm will never scale a font smaller than 6 pixels wide by 9 pixels 
high.

Host uses Windows character set
Use this option to change the default character set used by the selected 
terminal type to the 8-bit (non-Unicode) character set used by Windows.  
You will need to select a font that supports all the characters in the 
Windows character set if this option is checked; the AccuTerm font only 
supports the OEM (code page 437) and Western ANSI (code page 1252) 
character sets.

Euro character
If your host application needs to display the Euro currency symbol, enter the 
ASCII value of the Euro symbol, as used on your system.

Note: there is no standard value for this symbol. Some possible values are 
128 (Windows ANSI), 164 (Latin-1 currency and Latin-9 Euro) and 213 
(IBM modified code page 850).
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Color Settings

Windows is capable of displaying text in a wide variety of colors. The 
colors are separated into character color and the background color. Most of 
the terminals being emulated do not support color. Instead, they have visual 
attributes like normal, reverse, dim, blink, underline, etc. AccuTerm allows 
you to map the various terminal visual attributes into a combination of 
character and background colors.

AccuTerm uses a palette of 16 colors. Since most systems are capable of 
displaying more than 16 colors, AccuTerm allows you to customize its 
palette by selecting a Color Scheme or Visual Style, or by clicking the 
Customize Palette… button. The palette also includes 6 colors used to 
draw borders when using Visual Styles.

The mapping of visual attributes to colors is displayed as a table with an 
entry for each possible attribute. The Color column shows sample text 
displayed in the selected character and background color along with a button 
to change the colors. The Border column shows the selected border style 
for the attribute. Click the Change button to select different character or 
background colors. If borders are enabled (see Border Style below), choose 
the border effect for the attribute from the drop-down list.
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Color Schemes

Default Colors: resets the palette to the 16 basic Windows colors, and 
resets the attribute color mapping. This is often a useful starting point 
when defining your own color mapping.

System Colors: sets several colors in the palette to “system colors” 
defined in the Windows Display Properties. The following standard 
colors are replaced by a system color:

Black = Window Text Color
White = Window Background Color
Dark Blue = Highlight Background Color
Brown = Highlight Text Color
Light Gray = 3D Light
Dark Gray = 3D Shadow

Other palette colors are set the same as the default colors. Attribute 
color mapping is set so that Normal, Dim, Reverse and Underline use 
system colors from the modified palette.

Monochrome Colors: resets the palette to the 16 basic Windows 
colors, then sets the atttribute color mapping so that character and 
background colors are black, white or gray. Select either darkor light 
background for the Normal attribute. This setting often works well with 
Unix and Linux utilities where a combination of visual attributes and 
direct colors are used.
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Visual Styles
Visual Styles can be use used to modernize character-based applications by 
displaying screen elements in a style that resembles typical Windows 
screens. When you select a Visual Style, AccuTerm resets the palette to the 
system colors as described above. Next, typical Windows colors are 
assigned to the visual attribute mappings. Then the Border Style setting is 
changed to Thin and a border effect is assigned to specific attributes.

When using Visual Styles, use the following attributes to display screen 
elements:

Screen background: normal
Field labels, headings, etc: normal
Disabled labels: dim
Active entry field: reverse
Inactive entry field: dim reverse
Highlighted field: reverse underline
Disabled field: dim reverse underline
Command button: underline
Inactive button: dim underline

Classic Windows: sets the palette to the system colors, and sets the 
attribute color mapping as described above. Uses the inset border style 
for text fields.

Windows XP: sets the palette to the system colors, and sets the 
attribute color mapping as described above. Uses the flat border style 
for text fields.

If your application uses different attributes for screen elements, feel free to 
modify the colors and border effects to work with the attributes used by the 
application.
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Protected Attribute
The Wyse 50 and Wyse 60 emulations require a visual attribute to be 
assigned as the “Protected” attribute. To select the Protected Attribute, 
click on the drop-down arrow, then select which visual attribute should be 
used as the default protected attribute.

Border Style
If you are using Visual Styles (or the AccuTerm private programming 
command to draw borders), you must select a border style. Choose thin for a 
one-pixel border, or thick for a two-pixel border. When external borders are 
selected, vertical border lines are drawn in adjacent character cells. 
Otherwise they are drawn inside the character cell and sometimes overlap 
the left or right edge of the character; thin borders work best with smaller 
font sizes, but are less dramatic than thick borders.

Line Drawing
AccuTerm supports the line and box drawing characters used by the native 
terminals. AccuTerm supports three line drawing styles: normal, flat and 
beveled. Choose normal to draw lines using the current character color. 
Choose flat to draw lines using the outer flat border color. Choose beveled
to draw 3D lines using the outer highlight and outer shadow colors.
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Keyboard Settings

AccuTerm supports a programmable keyboard. All of the function keys and 
most of the keypad editing keys can be programmed.

Each terminal type has default programming for all of the keys which are 
native to that terminal. You do not need to program the default key codes. 
The default codes are displayed in gray text.

If you wish to override the default programming, or to program keys that are 
not native to the currently selected terminal type, you can enter you own 
codes here. Any key can be programmed with a character sequence (which 
is transmitted to the host when the key is pressed), or a script command, 
which is executed when the key is pressed.

The programmable keys are divided into eight categories: Normal, Shifted, 
Control, Shift+Control, Alt, Shift+Alt, Keypad and Shifted Keypad. The 
Normal key sequence is sent when one of the function keys is pressed by 
itself. The Control sequence is sent when a function key is pressed while 
holding down the CTRL key. The Alt sequence is sent if the ALT key is held 
down while pressing a function key. The Keypad sequence is sent when one 
of the editing keys is pressed. The Shifted, Shift+Control, Shift+Alt, and 
Shifted Keypad sequences are sent when the SHIFT key is held down in 
combination with any of the previous keys.

The Keypad and Shifted Keypad tabs are used for programming the 
special editing keys: BKSP, TAB, INS, DEL, HOME, END, PGUP, PGDN, 
LEFT, RIGHT, UP, and DOWN.

To reset the selected group of keys to their default values, click the Reset all 
to default button.
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Key Code
To manually program function and keypad keys, first select the Key Type
from the tabs at the top of the panel. Next, enter the desired sequence into 
the Key Code field. next to the key name. To enter control characters, hold 
the CTRL key and press the letter corresponding to the control character you 
want to program. For CR (enter), DEL (delete) and TAB control codes, hold 
the CTRL key and press the ENTER, DELETE or TAB key.  For the ESC
control code, press CTRL + [ , and for the BS (backspace) control code, 
press CTRL + H.

The carat (^) and backslash (\) characters are used as special prefixes in 
keyboard programming. If you need to enter either of these characters, just 
enter two of them (^^ or \\). This applies to both codes to transmit to the 
host and script commands.

Alternatively, use the following table to enter control codes using special 
prefix characters:

Key
sequence

Control
code

AccuTerm
notation

Key
sequence

Control
code

AccuTerm
notation

CTRL + @ NUL ^@ CTRL + P DLE ^P

CTRL + A SOH ^A CTRL + Q DC1 ^Q

CTRL + B STX ^B CTRL + R DC2 ^R
CTRL + C ETX ^C CTRL + S DC3 ^S
CTRL + D EOT ^D CTRL + T DC4 ^T

CTRL + E ENQ ^E CTRL + U NAK ^U

CTRL + F ACK ^F CTRL + V SYN ^V

CTRL + G BEL ^G CTRL + W ETB ^W

CTRL + H BS ^H CTRL + X CAN ^X

CTRL + I HT ^I CTRL + Y EM ^Y

CTRL + J LF ^J CTRL + Z SUB ^Z

CTRL + K VT ^K CTRL + [ ESC ^[

CTRL + L FF ^L CTRL + \ FS ^\

CTRL + M CR ^M CTRL +] GS ^]

CTRL + N SO ^N CTRL + ^ RS ^~

CTRL + O SI ^O CTRL + _ US ^_
^ ^^ \ \\
DELETE DEL ^?

To program a key with a script command, enclose any valid VBA statement 
in square brackets ([ ]). See the Scripting section of the Programmers 
Guide for more information on scripts.
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Key Caption and Tip
When the Function Bar is displayed, you can enter a caption for each 
function key. The caption will override the default button caption in the bar 
for that key. Enter the caption in the Caption | Tip field. Strive to keep the 
caption text short, as the key buttons are quite small. You can also enter an 
optional help tip in this field. Separate the caption and tip using a vertical 
bar (|). When the mouse hovers over the key button in the Function Bar,
the tip will be displayed briefly.

You can enter a tip even if you do not enter a caption or display the 
Function Bar. Just begin the Caption | Tip field with a vertical bar and 
enter the tip. This is useful for documenting the purpose of the key 
programming

Locking Programmed Keys
Most terminal types provide commands for the host to program the function 
keys. If you would like the host to be able to reset and reprogram the keys, 
select the Unlocked – host can reset or reprogram key option. If you 
would like the host to be able reprogram keys, but not reset them to their 
default values, select the Locked – host cannot reset keys to defaults
option. If you would like to prevent the host from resetting or 
reprogramming key, select the Locked – host cannot reset or reprogram 
keys option.

Mapping F11 through F16
Some terminals (like Wyse 50 and 60) have more than 12 function keys on 
their native keyboard. Since the PC keyboard only has 12 function keys, 
AccuTerm allows you to map the native F11 through F16 keys to PC 
keyboard CTRL + F1 through CTRL + F6 (and native SHIFT + F11 to SHIFT + 
F16 to PC CTRL + SHIFT + F1 through CTRL + SHIFT + F6).

Show function key bar
Selecting this option causes AccuTerm to display a row of function key 
buttons at the bottom of the terminal window. Buttons on this bar duplicate 
the standard 12 keyboard function keys. The function key bar button 
captions can be customized, as described above.
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Printer Settings

AccuTerm 2K2 uses the printer in two ways: First, AccuTerm can print the 
contents of the terminal screen by using Print Screen context menu 
command or by receipt of the appropriate command from the host computer.

The other way AccuTerm uses the printer is to emulate a “slave” printer 
attached to a terminal’s Aux (printer) port. This mode is enabled by using 
the Printer On context menu command or by receipt of the Printer On
command from the host.

AccuTerm can print in two modes: text and graphics. Text is the mode used 
by “real” terminals. This mode is different from normal Windows printing in 
that the Windows printer driver is not used. For screen printing, text mode 
sends the screen text to the printer. For slave printing, AccuTerm passes raw 
data, including control characters and escape sequences from the host 
directly to the printer (or spooler). In text mode, the host computer is 
responsible for setting printer font sizes and page orientation by sending the 
appropriate printer commands.

In graphics mode, AccuTerm prints an image of the screen on the printer, 
using the Windows printer driver. When the screen is printed in graphics 
mode, the printed image includes text, line drawing characters, any images 
displayed on the screen, and may optionally include the screen background 
and colors. For slave printing, AccuTerm understands CR (carriage return), 
LF (line feed) and FF (form feed) control characters, but other control 
characters and escape sequences are ignored.

You can select the paper size and page orientation used for graphics mode 
printing by clicking the Page Setup button in the printer settings tab.  For 
slave printing in graphics mode, you can also select the font.

Printer Selection
By default, AccuTerm disables printing. You can select the system default 
printer by clicking the Use Windows Default Printer option. If you want to 
select a different printer, select the Use Specific Printer option, then select 
a printer from the drop-down list. The user can override the printer selection 
by choosing a different printer in the Printer tab, from the Preferences
option of the context menu.
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Note: selecting a specific printer for an AccuTerm Internet Edition 
connection is not recommended, since actual printer name you select is 
stored in the connection file. It is unlikely that your users will have a printer 
with the chosen name installed on their PC.

Screen Print Settings
AccuTerm can print the screen in Text or Graphics modes. In Text mode, 
only the text characters currently displayed on the screen are printed. In 
Text mode, you can elect to eject the page from the printer before the 
printout, after the printout or both.

In Graphics mode, an “image” of the current screen is printed, including 
special symbols like line drawing characters. You can elect to print the 
background (shading and highlighting) or print the screen in color if you 
have a color printer. In Graphics mode, you can select the page orientation, 
paper size and paper source by clicking the Page Setup button.

Slave Printer Settings
AccuTerm can print to the slave printer in either Text or Graphics mode. In 
Text mode, you can eject the page from the printer before the printout, after 
the printout or both. In Graphics mode, you can select the font, page 
orientation, paper size and paper source by clicking the Page Setup button.

Printer Close Timeout
Enter the number of seconds to wait after receiving a Printer Off command 
before closing the print job. Usually, when the host computer needs to print 
a report, it usually sends a Printer On command, sends the printer data and 
then sends a Printer Off command. But some host programs send a Printer 
On command, send some data to the printer, send a Printer Off command, 
and send some other data to the screen, and then send another Printer On
command, and send more data to the printer, etc. Because of this, AccuTerm 
has no way of knowing when the host is finished sending the print job. The 
only way it can determine this is to wait for a set amount of time after the 
Printer Off command before closing the job. If this field is set to the default 
of 5 seconds, AccuTerm waits 5 seconds after the Printer Off command has 
been received before closing the print job.

This causes a delay when printing under AccuTerm. If all your host 
programs always turn the aux port on, send all the data and then turn it off, 
you can reduce this number to 1 or 0. If you have programs that are 
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constantly turning the aux port on and off, you may need to adjust this 
number until things work correctly.
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File Transfer Settings

AccuTerm supports several file transfer protocols. The File Transfer tab 
allows you to adjust some of the parameters used control thevarious 
protocols, select default operating modes and specify default directories. 
There are sections for ASCII options, X/Y/Zmodem options, Kermit 
options, as well as options for default modes and directories.  Thedefault 
values for most of these options should not be changed without an 
understanding of the protocol and the companion file transfer program on 
the host computer.

ASCII Settings
When transferring a file from your computer to the host computer (upload) 
using the ASCII protocol, the each line may be terminated with a CR, LF or 
CR LF combination.  Select the appropriate end of line for the host computer 
by checking the appropriate button.

ASCII is a “blind” protocol.  The receiving computer cannot inform the 
sending computer when it is safe to transmit data.  In order to perform 
reliable ASCII uploads, you may need to specify an appropriate Interline 
delay time.  After each line is sent to the receiving computer, AccuTerm 
will wait for the specified time before sending the next line.  Specify this 
value in milliseconds.

The Interline delay setting also applies to the Edit Paste and Edit Paste 
From commands.

Timeout Settings
When using any of the X/Y/Zmodem protocols, you can specify the number 
of seconds before a timeout occurs.  If the other machine fails to respond 
within the number of seconds specified here, the protocol will attempt to 
resend the previously sent message.

Kermit Settings
The Kermit file transfer protocol is popular with minicomputer and 
mainframe systems.  There have been many revisions of this protocol, and it 
may be necessary occasionally to modify some of these settings to 
communicate with another Kermit program.
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Kermit settings: Defaults
These default options may be set (checked) or reset (un-checked) as desired.  
When AccuTerm Kermit is negotiating with the other Kermit program, any 
of the checked options will be requested, and if the other Kermit is capable, 
the option will be used.

The “Quote eighth bit” option should be used when the communications 
path only supports 7 data bits, or when the other machine is not capable of 
processing eight bit data.

The “Compress data” option may be used to perform rudimentary data 
compression.  Not all Kermit programs perform data compression.

The “CRC block check” option instructs Kermit to use CRCerror detection
instead of the standard simple checksum error check.  This results in more 
reliable transfers, especially over noisy phone lines.  Not all Kermit 
programs perform CRC error checking.

Default Mode
Select Text or Binary as the default transfer mode (used only for Kermit 
and Zmodem protocols).  When you select Upload or Download from the 
main menu or toolbar, the default mode will be selected.  Also, select 
whether to overwrite existing files when downloading.  You also can change 
any of these options in the Upload or Download dialog before performing 
the transfer.

Default Upload/Download Directory
Enter the drive and directory where you want received files to be stored by 
default.  You can change this directory in the Download dialog before 
performing the transfer.  If you set the Automatic Zmodem download
option, then this is the directory where the received files are stored.

Automatic Zmodem Download
If this option is set, then AccuTerm will automatically begin receiving files 
using the Zmodem protocol when the other machine begins sending files 
using the Zmodem protocol.  The files are saved in the Default 
Upload/Download directory.
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Miscellaneous Settings

The Miscellaneous Settings tab is used for setting various options, such as 
how paste operations are handled and the sound of the terminal bell.

Paste Options: line end
When the clipboard is “pasted” to an AccuTerm session, AccuTerm 
transmits the clipboard text to the host computer. The line end options 
specify what is transmitted at the end of a line of text. Options include CR 
(default), LF, CF+LF, TAB, none or a user-defined character. To specify a 
user-defined character, select the User defined option and enter the ASCII 
code of the character to be transmitted at the end of each line.

Paste Options: do not send line end after last line
If you want to suppress the final end-of-line (or only end-of-line if only a 
single line is in the clipboard), select this option.

Paste Options: paste end
After pasting the clipboard to an AccuTerm session, AccuTerm can 
transmits an optional paste end character. Normally, AccuTerm does not 
transmit any character at this time, but you can select EOF (which is the 
SUB or CTRL + Z control code), or a user-defined character. To specify a 
user-defined character, select the User defined option and enter the ASCII 
code of the character to be transmitted at the end of a paste operation.

Terminal Bell Sound
The sound generated by AccuTerm upon receipt of the ASCII BEL control 
code can be customized. The default sound depends upon whether a sound 
card is installed or not. If a sound card is not installed, a “beep” is produced; 
otherwise the sound defined by the Control Panel Sounds applet as the 
“Default Beep” is played.

Other options which may be selected are: play wave file, system event, 
beep or silent. To play a wave file, select this option and enter the full path 
for the wave file to be played. To use a sound associated with a system 
event, select the event from the dropdown list. System events are associated 
with wave files in the Control Panel Sounds applet. To use a true beep, enter 
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the frequency of the beep in Hz, and the duration in milliseconds. The 
default is 400Hz for 500ms. The frequency must be between 200Hz and 
4000Hz. The duration must be between 100ms and 5000ms.

Advanced (Custom Features)
Click the Advanced button to show any custom features that can be 
selected. See the Programmers Guide for more information on the custom 
features of AccuTerm 2K2.
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AccuTerm Internet Connection Script

AccuTerm 2K2 Internet Edition uses a script, written in Visual Basic for 
Applications (VBA), to automate certain processes. Each session file 
includes its own script, which may be customized. When a new session file 
is created, a default script is also created for that connection. To open the 
Script Editor window, select Script from the Tools menu or click the 

button.

In AccuTerm 2K2 Internet Edition, scripts are used to automate the logon 
process as well as for cleanup. Scripts may also be called by the host 
program, or invoked by a function key (as programmed in the Keyboard 
section described previously).

The Connect() subroutine is called when AccuTerm has successfully 
established a connection with the host system. Modify the default script to 
log into your host system and start the application you want the user to have 
access to from the web.

Various blocks in the default Connect() subroutine can be “un-
commented” to support either hard-coded user ID and password, or prompt 
for user ID and password. The login sequence uses a series of Output
statements (methods) to send a string to the host followed by WaitFor
statements (methods) to wait for the desired response from the host. You 
will probably need to customize this section.

The Disconnect() subroutine is executed when the AccuTerm session is 
closed. This function is designed to handle any special cleanup functions. 
Since the connection is probably already closed, often there is not much you 
can actually do in this function. The default Disconnect() subroutine 
performs no function.

The Disconnected() subroutine is executed when the connection to the 
host has been terminated, either deliberately by the host, or due to network 
errors. This function can be used to display a message to the user, close the 
browser window, etc. There are two predefined actions in the standard 
sample script: display a “reconnect” message or close the browser window.
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You can create other subroutines and functions which are called by your 
Connect() or Disconnect()routine (or from function keys or host 
commands). Subroutines begin with the Sub keyword followed by the name 
of the subroutine. If the subroutine requires arguments, enclose them in 
parentheses. The last statement in a subroutine is End Sub.

Functions are similar to subroutines, and begin with the Function
keyword, and end with the End Function statement. Functions return a 
value; simply assign the return value to the function name within your 
function code.

Controlling AccuTerm with Scripts
From a script’s perspective, AccuTerm consists of a set of objects which can 
be manipulated. The main object, AccuTerm, may be used to control the 
general settings of AccuTerm. The Session object is the most useful 
object for controlling AccuTerm. Using the Session object, you can 
change any of the session settings, communicate with the host system, 
manipulate the screen, etc. Note that not all properties and methods of all 
objects are available or meaningful in the context of an AccuTerm Internet 
session. For example, the AccuTerm.WindowState property is notrelevant
in this context and will generate an error if used. See the AccuTerm Object 
Reference chapter in the Programmers Guide for a description of 
AccuTerm’s object model.

There are several built-in objects which can be referenced while executing 
scripts. These are the AccuTerm object and the ActiveSession object.

For compatibility with the standard version of AccuTerm 2K2, the 
Sessions collection and the InitSession object are also defined, 
however, the Sessions collection contains exactly one session and no 
other sessions may be added to it, and the InitSession object references 
the same session as the ActiveSession object.

Cookies
The Cookie collection provides a way to pass values between the HTML 
session and the emulator session. Cookies which arepassed between HTML 
and emulator sessions must be “permanent”, or “disk” cookies, not 
“temporary” or “memory” cookies. The scope of cookies is restricted to the 
URL of the directory of the session connection (.ats, .atss, .atsn) file.
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You can retrieve the value of a “cookie” which was set by the web server (or 
by a script in the HTML page) by accessing the Cookie collection:

x$ = Cookie("MyCookie")

Likewise, you can set the value of a cookie so that the web server (or a 
script in the HTML page) can retrieve its value:

Cookie("HostResult") = "Success"
Cookie("AccountNumber", 1800) = "11199"

The second form specifies the expiry time of the cookie in seconds. In the 
example, the cookie is valid only for 30 minutes (1800 seconds). If you do 
not specify an expiry time, the default of 1 hour is used.

WebBrowser Object
An object representing the browser hosting the emulator session connection 
(.ats, .atss, .atsn file) is available as the WebBrowser object. While much 
functionality of this object is restricted, the Quit and Navigate methods 
are available and might be useful in some circumstances. For example, you 
can use the Quit method in the Disconnected function to close the 
current browser window (the one displaying the terminal session). This is 
actually one of the choices in the sample script:

WebBrowser.Quit

SafeMode Property
At times, it might be useful to determine whether the current connection is 
“safe” or “unsafe”.You can query the SafeMode property to determine this 
state:

If SafeMode Then …

For more information on scripting, or the AccuTerm object model, please 
refer to the Programmers Guide.
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Testing a Connection

After configuring the connection settings and script, you can use the 
Connection Designer to test your connection file. Normally, the terminal 
session in the preview pane is “disconnected” from the host. To connect to 
the host, select Connect from the Tools menu or click the button. 
AccuTerm will attempt to connect the host configured in your connection 
file, and once connected, the Connect subroutine in your script will be 
executed. In the Script Editor window, you may set break-points in your 
connection script to aid in debugging the script.

To test the Disconnect script, select Disconnect from the Tools menu or 

click the button.
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DEPLOYING ACCUTERM INTERNET 
CONNECTIONS

Deploying an AccuTerm 2K2 Internet Connection on the Internet(or on an 
intranet) requires two components: a Web Server and the Host Computer 
that you want to connect to.

Web Server

After you create a terminal session connection (.atss, .atsn) file with the 
Connection Designer, you need to link the new terminal session into your 
web page. Choose an appropriate web page, and modify the web page file 
by adding a hyperlink to the new HTML link file (created when you saved 
your session connection file). The HTML link file contains a sample 
hyperlink which you can copy and paste into your web page file. Then, 
upload the modified web page file, the session connection (.atss, .atsn) file 
and the HTML link file to your web server.

The web server does not need to be (and usually is not) the same machineas 
your host. The web server can be located anywhere on the Internet (or 
intranet), as long as end-user's PC can access it. The only function that the 
web server performs when used with AccuTerm 2K2 Internet Edition is to 
deliver the HTML and session connection (.atss, .atsn) files to the browser 
on the user's PC.

If you install the session connection (.atss, .atsn) file on a local (intranet) 
web server, and you have selected the intranet version of the HTML link 
file, you also need to upload the atiecli5.cab file from the 
...Atwin\LocalServerFiles directory to your web server. If your HTML link 
file includes the GUI support option, you should also upload the 
atguisvr_install.cab file to your web server.
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IIS Issues
When you deploy AccuTerm Internet Edition connection files on an IIS web 
server, it is sometimes necessary to register the “.ats”, “.atss” and “.atsn” file 
extensions as MIME Type “application/octet-stream” in the IIS 
configuration. MIME types are found in the HTTP Headers tab of the Web 
Sites Properties dialog; click the File Types button to define new extensions.

Apache Issues
For Apache web servers, it is sometimes necessary to add these lines to the 
mime.types file (note there is a tab between the two columns):

application/ats ats
application/atss atss
application/atsn atsn
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Host Connection

The final task required to get everything working is to connect your host to 
the Internet (or intranet). It is beyond the scope of this document to provide 
detailed instructions on how to connect your host to the Internet, but we can 
offer some general guidelines.

First, your host must be able to receive Telnet or Secure Shell connections 
across a network. This normally requires that the host machine have an 
Ethernet adaptor and TCP/IP networking software configured. All Unix-
based hosts should support both Telnet and Secure Shell. NT-based hosts 
may only support Telnet.

Second, you will need a permanent Internet connection with a static IP 
address. You may be able to use a DSL or Cable Modem connection, or 
some other high-speed link. A static IP address is necessary, because the 
session connection (.atss, .atsn) file contains the IP address of the host 
machine. If your host gets its IP address assigned dynamically, then you 
would need to update the session connection file each time the host’s IP 
address changes.

Finally, you need to consider security. Often, a gateway or router is used 
between your Internet connection and the local area network which connects 
to your host machine. The gateway or router can be configured to route 
inbound Telnet or Secure Shell requests to the IP address of your host on the 
local network. The outside world sees the IP address of the gateway or 
router, not the IP address of the host. This is the IP address that should be 
specified in your session connection file. The gateway may also be able to 
restrict inbound connections and only allow connections from specific 
addresses.

AccuTerm 2K2 supports Secure Shell connections between the user's PC 
and the host. If you are concerned about privacy, use Secure Shell instead of 
Telnet. The entire Secure Shell session is encrypted, including login name 
and password. AccuTerm supports both Secure Shell v1 and v2 protocols, 
with triple-DES, blowfish and AES ciphers and password or public key 
authentication.



58 Deploying AccuTerm Internet Connections

To use ssh, the host machine must be running an ssh server program (sshd, 
similar to telnetd). The ssh server is available for most Unix-based hosts 
(see www.openssh.org for more information).

If you need to connect to an NT-based host which does not support ssh, 
consider using a small Linux machine as a gateway. The Linux gateway can 
accept inbound ssh connections, then automatically open a Telnet 
connection to the NT-based host.
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ACCUTERM INTERNET CLIENT

In order to display a terminal session within the Internet Explorer browser, 
the AccuTerm 2K2 Internet Client program must be installed on the user’s 
PC (client). The AccuTerm 2K2 Internet Edition Client program is installed 
on the user’s computer automatically by the browser. The first time the user 
connects to a site requiring the AccuTerm Internet Client, the necessary files 
are automatically downloaded and installed. Subsequently, the files are only 
downloaded if newer versions of one or more files become available.

The files may be downloaded from the Internet or from an intranet. When 
you create a connection, you can choose to create an Internet or intranet
HTML link file. If you choose to create an Internet link file, the component 
files are downloaded from AccuSoft’s web site. The user must fill out an 
information form, and accept the fee-free software license agreement before 
the software is installed. The client installation has been optimized so that 
only those files which are not present on the user’s computer (or are out of 
date) are downloaded.

If an intranet html file is used, the files are obtained from the atiecli5.cab
file on the local web server. The atiecli5.cab file is not optimized for 
Internet deployment.

In either case, the component files are distributed in a .cab filewhich 
includes a “digital signature” identifying the source of the files as 
“Schellenbach & Assoc., Inc. dba AccuSoft Enterprises”. The browser may 
display the certificate used to sign the file before installing the components
and allow the user to cancel the installation of the component files.
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CUSTOMIZING THE WEB PAGE

The AccuTerm Internet Edition terminal session is normally opened in a 
new browser window. This is because Internet Explorer will terminate the 
terminal connection if the user navigates away from the AccuTerm session 
page (either by entering an address in the address field, or by clicking on the 
Back or Forward buttons). The HTML link file created by the Designer 
exhibits this behavior. By modifying this HTML file, you can alter the 
browser’s functionality in the new window, or even display the terminal 
session in an HTML frame.

Frames
AccuTerm 2K2 Internet sessions may be displayed inside of a frame. To 
display the emulator page inside of a frame, simply change the hyperlink to 
something like:

<p><a href="atie_frame.htm" 
target="main">AccuTerm 2K2 Internet Edition 
in a Frame</a></p>

This will load the “atie_frame.htm” page into the “main” frame when the 
user clicks the link. Once the page is loaded, the terminal session will begin.

Note: loading a different page into the “main” frame will terminate the 
terminal session.
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Window Options
The Window.Open( ) method (used in the hyperlink that opens an 
AccuTerm Internet Session) has several optional arguments that you can use 
to customize the IE window where the AccuTerm page is displayed. The 
Open( ) method has an optional, third, string argument that can contain 
up to seven sub-arguments. The sub-arguments require a “yes” or “no” 
value. The following sub-arguments are supported: toolbar, location, 
directories, status, menubar, scrollbars and resizable. 
To open the terminal session in a new window, without a toolbar or status 
bar, use:

<p><a href="#" 
OnClick="window.open('atie_demo.htm',
'demo_window','toolbar=no,status=no');">
AccuTerm 2K2 Internet Session</a></p>
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TROUBLESHOOTING

Browser Compatibility
AccuTerm 2K2 Internet Edition only supports the Microsoft Internet 
Explorer browsers. Internet Explorer 3.02 and above are supported. 
AccuSoft recommends using IE 6.0 or above.

Unable to establish SSH connection
If you are unable to establish an ssh connection to the host, it is usually 
caused by not having the 128 bit High Encryption Pack installed on the 
client PC. Make sure 128 bit encryption is installed by clicking Help ->
About Internet Explorer. Check the Cipher Strength setting.

Nailed Ports
Because all users accessing a given web page will share a single session 
connection (.atss, .atsn) file, using “nailed ports” is not recommended.

Can’t install client program from web
Security at some organizations prevents the installation of the AccuTerm 
2K2 Internet Client programs from AccuSoft's web site. This code is 
downloaded automatically by Internet Explorer using http, but some firewall 
and/or proxy server configurations seem to block this function. In this case, 
you might need to ship a Client Install CD to the customer. You can create a 
Client Install CD by copying the files in the \Atwin2k2\INetCli folder of 
your program CD to the root directory of a blank CD.

Alternatively, the user can download the client installation from AccuSoft’s 
web site and manually install the client program. The current URL for the 
AccuTerm 2K2 Internet Client install is 
http://www.asent.com/downloads/setup/at2k2ie-client/atiecli5.exe.
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fingerprint, 26
Font, 35

character set, 36
Euro character, 36
legible, 36
scaling, 35
size, 35
style, 35

Function key bar, 43
function key programming, 42
Graphic mode

enabling, 33
Hardware Requirements, 4
History buffer, 33
History rows, 33
Host Connection, 59
HTML, 61
IIS, 58
Importing a key, 26
Installation, 5
Internet, 61
Internet Client, 61
Internet Explorer, 3
intranet, 61
Kermit Settings, 48
Keyboard

key caption, 43
key code, 42

Line wrap, 34
MIME Type, 58
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Mouse
enabling, 34

mouse wheel, 33
Normal mode, 32
OpenSSH, 24
Paste, 47
Paste options

line end, 50
paste end, 50

Printer
job close timeout, 45

Printer selection, 44
RSA, 24
Safe connections, 12
Screen print, 45
Screen sizes, 32
Script, 52

controlling AccuTerm, 53
Scripting language, 2
Scroll bars, 32
Scrollback, 33
Secure Shell. See SSH

U2 Device Licensing, 23
Settings, 12, 16

Colors, 37
Connection, 17
File Transfer, 47
Font, 35
Keyboard, 41
Miscellaneous, 50
Printer, 44
Screen, 32
Terminal Type, 28

Setup, 5
Slave printer, 45
Software Requirements, 4
SSH, 21

authentication, 22
break character, 22
Host, 21
IP address, 21
keepalive, 23
key, 22

Key location, 27
Key management, 24
options, 22
outbound coalescing, 23
port, 21
preferred cipher, 23
SSH version, 22
terminal type, 22
timeout, 22

Status line, 29
Strip eighth bit, 17
System Requirements, 4
TCP/IP, 18, 21
Telnet, 18

alternate break option, 19
binary option, 19
bypass option, 19
echo option, 19
host, 18
host type, 18
keepalive, 20
options, 19
outbound coalescing, 20
port, 18
terminal type, 20
timeout, 18
U2 device licensing, 20

Terminal emulation, 28
Testing, 56
Timeout, X/Y/Zmodem, 47
Troubleshooting, 65
Underline, 34
Unsafe connections, 12
VBA, 2
Video pages, 32
Visual attributes, 37
Visual Styles, 39
Web Server, 57
wheel mouse, 33
Wrapping, 34
Zmodem, automatic download, 
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